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Pumpamise optimeerimine (WaterGEMS) 
 
Ülesande püstitus 
Selles näites õpid sa kasutama Darwin Scheduler töövahendit. Lähteülesandes on 6 pumpa, 
kolm mahutit ning üks reservuaar. Kõik algtingimused on elementidele sisestatud. Näite 
eesmärk on kasutada Darwin Scheduler töövahendit, et leida pumpadele kõige efektiivsemad 
töötamise graafikud. Tegemist on protseduuriga, mida oleks võimalik ka käsitsi teha, kuid 
selleks võib minna sadu kui mitte tuhandeid erinevaid EPS simulatsioone. Darwin Scheduler 
teeb seda aga sinu eest ning kuvab seejärel kõige säästlikumad lahendid veevõrgutöö 
juhtimiseks. Peale selle näite läbimist suudad: 
 

• Käivitada mistahes süsteemis Darwin Scheduler analüüsi. 
• Soovitada energiasäästu skeeme olemasolevale süsteemile. 

 
Olles WaterGEMS tarkvara käivitanud ava fail: PumpamiseOptimeerimine.wtg. 
 

 

Märkus: Näitefail sisaldab kolme pumplat ning mahutit, mis teenindavad kolme survetsooni. 
Tegemist on skeletoniseeritud mudeliga, kui kõik piirkonna tarbimised on koondatud ühte 
tarbimissõlme. Pumpade tööd kontrollitakse läbi mahutite veetasapindade. Mudelis on üles 
seatud ka värvikood. 
 

1) Saamaks aimu, mismoodi süsteem praegu töötab, veendu, et aktiivne stsenaarium 
oleks EPS ning käivita see. 

2) Sulge Calculation Summary dialoog ning pane tähele värvikoodi, mis mudelile lisatud. 
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3) Vali riba pealt: View > Drawing > Symbology. 
 

 
 
Märkus: Pane tähele, et torud on värvitud kiiruse, mahutid veetasapinna ning pumbad  
staatuse järgi. 
 

4) Tee topelt-klikk Status (Calculated) värvikoodi real (pumpade sektsioonis), et näha 
värvide ulatust ning nendega seotud väärtuseid. 
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5) Kliki nupul Cancel, et sulgeda dialoog. 
6) Vali riba pealt: Analysis > Calculation > Times 
7) Kliki nupul Play ning vaata animatsiooni. 

 

 
 
Märkus: Mahuti sümbol peaks suurenema selle täitumisel, pumba värv muutub punaseks kui 
see töötab ning torus olevat kiirust esitab toru värv. 
 

8) Riba pealt: View > Graphs. 
 

 
 

9) Pane tähele, et kolm graafikut on juba üles seatud. Me soovime lisaks aga vaadata 
kolme pumba vooluhulka ning kolme mahuti veetasapinda. 

10) Kliki nupul New ning vali Line-Series Graph. Kuvatakse dialoog Select. 
11) Vali jooniselt T-1, T-2 ning T-3, seejärel kliki Done. 
12) Dialoogis Graph Series Options veendu, et valitud stsenaarium oleks EPS. 
13) Võta linnuke ära Hydraulic Grade ning vali Flow (Out Net) ning ka Level (Calculated). 
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14) Kliki OK, et vaadata graafikut. 
 

 
 

15) Kui oled graafikutele pilgu peale visanud, siis sulge see. 
16) Dialoogis Graph, tee parem klikk Graph-1peal ning vali Rename. 
17) Nimeta graafik kui Tanks. 
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Energia maksumuse arvutamine 
 

1) Vali riba pealt: Analysis > Energy Cost > Scenario Energy Cost. 
 
Märkus: Pane tähele, et kõik pumbad on juba üles seatud kasutamaks Energy Pricing-1 
maksumusgraafikut. 
 

 
 

2) Kliki ikoonil Energy Pricing ikoonil ning vaata hinnaskaalat, mis on sinu eest juba üles 
seatud. 

 

 
 

3) Kliki Close nupul, et sulgeda dialoog. 
4) Veendu, et EPS stsenaarium oleks valitud. 
5) Käivita maksumusarvutus stsenaariumile EPS klikkides nupul Compute. 
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6) Täida materjali lõpus vastavad tabelid (päevane maksumus). 
7) Kliki Close, et sulgeda dialoog. 
8) Vali riba pealt: View > Graphs, et avada Graphs dialoog uuesti. 
9) Vali graafik nimetusega Energy. 

 

 
 
Märkus: Pane tähele, et PMP-2 – EPS omab suuremaid kulutusi energiale hetkel, kui kaks 
pumpa töötavad selles pumplas (tunnivahemik 10.5 – 15). See on tingitud asjaolust, et pump 
töötab suuremale vastusurvele. 
 

10) Sulge graafik. 
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Süsteemi profiili loomine 
 

1) Riba pealt: View > Profiles. 
 

 
 

2) Kliki nupul New, et luua uus profiil. 
3) Dialoogis Profile Setup kliki Select from Drawing. 
4) Vali jooniselt reservuaar R-1 ning mahuti T-3. 

 
Märkus: Kahe valitud sõlme vaheline lõik muutub punaseks. 
 

 
 

5) Kliki Done nupul (paanil Select). 
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6) Kliki Open Profile. 
7) Dialoogis Profile Series Options veendu, et oleks valitud Results > Hydraulic Grade 

ning Physical > Elevation. 
 

 
 

8) Kliki OK, et vaadata profiili. 
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9) Kliki rohelisel Play nupul või juhul kui sul on endiselt Time Browser lahti, siis kliki seal 
aknas Play nuppu. Pane tähele, et esitatakse graafiku animeerimine vastavalt 
pumpade tööle. 

10) Nüüd kus oled näinud, kuidas profiil ajas muutub, sulge see. 
 
Märkus: Lähtefailis kasutatakse ajasammuna 1h, kui soovid, et sinu mudelit aga kiiremini 
arvutatakse, võid panna sammuks 2h. Seda saad teha Analysis > Calculation Options ning 
muuda ära parameeter Hydraulic Time Step (hours) = 2. Selles näites jääme siiski 1h peale. 
 

 
 

11) Salvesta oma fail. 
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Valikugrupi loomine 
 

1) Vali element PMP-1. 
2) Hoia all CTRL klahvi ning vali ka ülejäänud pumbad jooniselt. 
3) Parem klikk joonise alas ning vali Create Selection Set (kiirvalikumenüüst). 

 

 
 

4) Nimeta valikugrupp kui All Pumps. 
 

 
 

5) Kliki OK, et lõpetada valikugrupi loomine. 
 
Märkus: Pumpade valimiseks on ka alternatiivseid võimalusi. Näiteks Edit > Select by 
Element > Pump. Seejärel tee parem klikk ning vali Create Selection Set. 
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Darwin Scheduler 
 
Selles sektsioonis õpid sa seadistama ning käivitama Darwin Scheduler liidest. 
 

1) Vali riba pealt: Analysis > Darwin > Darwin Scheduler. 
 

 
 

2) Kliki nupul New ning vali New Scheduler Study. 
 

 
 

3) Dialoogi paremas osas, paanil Scenario, vali Scenario = EPS. 
 

 
 

4) Vali paan Pumps to Optimize. 
5) Kliki kolmandal nupul Initialize Table from Selection Set ning vali All Pumps 

valikugrupp, mille olid eelnevalt teinud. 
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6) Kliki OK, et valikuga nõustuda ning uuendada Darwin Scheduler dialoog. 
 

 
 

7) Vali paan Objective Elements ning korda samme 5-6. 
8) Parem klikk veeru Energy Pricing pealkirjal ning vali Global Edit. 
9) Dialoogi Global Edit veendu, et Operation = Set ning vali Value = Energy Pricing – 1. 

 

 
 

10) Kliki OK, et rakendada muudatused. 
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11) Vali paan Constraints. 
 

 
 
Märkus: Pane tähele, et selle paani all on omakorda neli alampaani. 
 

12) Vali paan Pressure. 
13) Vali neljas nupp Select from Drawing ning vali sõlmed J-4, J-7, ning J-9. 
14) Kliki nupul Done. 
15) Kliki kastis Override Defaults? Kõikide sõlmede osas ning sisesta alljärgneva tabeli 

kohaselt sõlmede miinimum ning maksimum surve. 
 
Sõlme Pressure (Minimum) (mH20) Pressure (Maximum) (mH20) 

J-4 0.0 9.0 

J-7 0.0 9.0 

J-9 70.0 79.0 
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Märkus: Neid väärtuseid kasutad selleks, et hoida mahuteid mõistlikes HGL vahemikes, 
võimaldades samas mõistlikke muutumise piire. 
 

16) Vali paan Tank. 
17) Kliki Select From Drawing ikoonil ning vali kolm mahutit joonise alast. 
18) Kliki Done peale seda, kui oled mahutid valinud. 
19) Sisesta kõikide mahutite puhul Level (Minimum Final Required) = 5. 
20) Sisesta Level (Maximum Allowed) (m) = 9.9 

 
Märkus: See kindlustab, et mahutid saavutada peale 24h simulatsiooni vähemalt algsele 
tasemele. 
 

 
 
Märkus: Kollased veerud tulevad mahutite parameetritest! Neid ei saa muuta. Siin saad 
lisada disaini parameetrid (valgetesse lahtritesse). 
 

21) Vali paan Objective Type ning vali sihifunktsiooniks Objective > Minimize Energy Cost. 
 

 
 
Märkus: Valides Minimize Energy Use annab sama tulemuse, mis ka Minimize Energy Cost kui 
just energia maksumus ei muutu. Sellisel juhul annavad erinevad valikud ka erinevaid 
tulemusi. 
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Seadistus on sellega paigas. 
 

21) Salvesta oma fail. 
22) Parem klikk olemasoleva analüüsi peal, vali New > New Optimized Run. 

 

 
 

23) Nimeta see ümber kui All Pumps. 
 
Märkus: Sul ei ole vaja muuta Objective Elements ega ka Pumps to Optimize paane. 
 

24) Kliki paanil Options ning sisesta Top Solutions to Keep = 10. 
 

 
 

25) Vali paan Stopping Criteria ning sea järgmised parameetrid: 
 

• Maximum Trials = 50'000 
• Maximum Non Improvement Generations = 100 
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26) Salvesta fail ning kliki nupul Compute (dialoogis Darwin Scheduler). 
 
Darwin Scheduler alustab nüüd võimalikest lahenditest sobivaima valikut. 
 
Märkus: Pane tähele, et esmastel variantidel genereeritakse veateateid, kuid see väheneb 
olulisel määral kui Darwin Scheduler leiab mõne lahendi, kus piirangutega konflikte ei leita. 
Sihifunktsiooni minimeerimise seisukohast (fitness) leiab Darwin Scheduler paremaid 
väärtuseid (häid lahendeid) ning järk-järgult paraneb tervikpilt. Darwin Scheduler leiab ühel 
hetkel parima grupi EPS lahendeid (kuid sa võid alati ka otsimisprotseduuri varem ära 
lõpetada). 
 

 
Lahendite läbivaatus 
 

1) Vali vasakult paanilt Solutions ning vaata 10 paremat lahendust. 
 

 
 

2) Vali lahend Solution 1 ning kliki nupul Graph, et vaadata esmast pumpade lahendit. 
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Märkus: Iga ülespoole liikuv joon tähendab, et pump hakkab tööle ning vastupidi, pump 
lülitab end välja. 
 
Kui joonise all legendi ei kuvata, siis: 
 

3) Kliki nupul Graph Options, mis avab TeeChart Editor akna. 
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Märkus: Pane tähele, et igale pumbale on antud omaette värvitoon. Nüüd oleks vaja lisada 
vastavasisuline legend. 
 

4) Kliki paanil Legend. 
5) Vali kastike Visible ning veendu, et Legend Style = Automatic. 

 

 
 

6) Vali paan Position ning vali Position = Bottom. 
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7) Kliki nupul Close rakendamaks tehtud muudatusi. 
8) Sulge graafik peale selle tulemuste analüüsi. 
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Lahenduse eksportimine stsenaariumiks 
 

1) Vali lahend Solution 1. 
2) Vali Export to Scenario. See avab dialoogi Export to scenario. 

 

 
 

3) Veendu, et oleks valitud Export Scenario? ning nõustu vaikimisi nimetustega kõigi 
seadete juures. 

4) Kliki OK, et saata see info stsenaariumisse. 
5) Peale eksporti kuvatakse sulle dialoog: 

 

 
 

6) Kliki OK ning vähenda Darwin Scheduler dialoogi. 
7) Vali riba pealt: Analysis > Scenarios, et kontrollida, kas uus stsenaarium on lisatud. 

 

 
 

8) Vali aktiivseks stsenaariumiks nüüd All Pumps – 1. 
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9) Käivita stsenaarium klikkides nupul Compute või valides riba pealt: Analysis > 
Compute. 

10) Vaata arvutuste kokkuvõtet dialoogis Calculation Summary. 
 

 
 

11) Sulge dialoog Calculation Summary peale info ülevaatamist. 
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Maksumusanalüüsi läbiviimine stsenaariumile All Pumps – 1 
 

1) Riba pealt: Analysis > Energy Cost > Scenario Energy Cost. 
2) Vali stsenaarium All Pumps – 1 ning kliki nupul Compute. 

 

 
 

3) Täienda materjali lõpus olevaid tabeleid. 
4) Kliki Close, et sulgeda dialoog Scenario Energy Costs. 
5) Ava graafikute haldur (View > Graphs). 
6) Ava graafikud Pumps, Energy ning Tanks. 

 
Märkus: Iga graafiku puhul pead sa neid uuendama stsenaariumile All Pumps – 1. Selleks kliki 
nupul Graph Series Options ning vali stsenaarium All Pumps -1. Võta linnuke ära kastist EPS 
ning kliki OK, et muudatusi kinnitada. 
 

 
 
Märkus: Järgnevad graafikud võivad erineda sinu omadest, sõltuvalt arvutussammust (hetkel 
arvutussamm 1h). 
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Märkus: Pane tähele, et kui kaks pumpa töötab paralleelselt, siis Darwin Designer valib 
pumba, mis töötab, juhuslikult. Kui kasutatakse paralleelselt samasuguseid pumpasid, siis on 
võimalik vältida juhuslikku valimist sellega, et üks pump töötab pidevalt. Edasistes tarkvara 
versioonides tehakse vahet, mis on peamine pump ning mis on tagavarapump. 
 

7) Sulge graafikud peale nende vaatamist. 
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Darwin Scheduler arvutus minimaalsete mahuti tasapindadega 
 
Eelmise arvutustes lubati mahuti tasapindadel langeda päris madalale. Veevõrguoperaator 
soovib nüüd aga uut arvutust, kus mahutite minimaalne veetasapind on 2m. Arvutuste 
kasutame seekord 1h arvutussammu (Calculation Options dialoogis). 
 

1) Taasta Darwin Scheduler dialoog. 
2) Kliki nupul New ning vali New Scheduled Study. 
3) Kui New Scheduler Study – 1 on valitud, siis dialoogi paremas osas, sektsioonis 

Scenario vali EPS. 
 

 
 

4) Liigu paanile Pumps to Optimize ning kliki nupul Initialize Table from Selection Set ning 
vali All Pumps. 

 

 
 

5) Kliki OK ning uuendatakse pumpade infot. 
 

 
 

6) Vali paan Objective Elements ning korda samme 4 – 5. 
7) Parem klikk Energy Pricing veeru päisel ning vali Global Edit. 
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8) Dialoogis Global Edit, vali Operation = Set ning Value = Energy Pricing - 1. 
 

 
 

9) Kliki paanil Constraints. 
 

 
 
Märkus: Pane tähele taas nelja paani, mis asuvad Constraints all. 
 

11) Vali paan Pressure. 
12) Kliki Select from Drawing ning vali sõlmed J-4, J-7 ning J-9. 
13) Kliki nupul Done. 

 
Märkus: Minimaalne veetasapind mahutites on nüüd 2m kõrgem kui eelmistes. 
 

14) Kliki kõigi 3 sõlme puhul kastis Override Defaults? Sisesta alljärgneva tabeli põhjal 
minimaalsed ning maksimaalsed väärtused. 

 
Sõlme Pressure (Minimum) (mH20) Pressure (Maximum) (mH20) 

J-4 2.0 9.0 

J-7 2.0 9.0 

J-9 72.0 79.0 
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15) Vali paan Tank. 
16) Kliki ikoonil Select From Drawing ning vali jooniselt kolm mahutit. 
17) Kliki nupul Done kui oled mahutid valinud. 
18) Kõikide mahutite osas sisesta: Level (Minimum Final Required)(m) = 5 

 
Märkus: See kindlustab, et mahutite veetasapinnad naasevad nende algsetele tasemetele 
(24h lõikes). 
 

19) Lisa: Level (Maximum Allowed) (m) = 9.9 
 

 
 

20) Vali paan Objective Type ning vali Objective = Minimize Energy Cost. 
 

 
 

20) Teise arvutuse seaded on sellega paigas. 
21) Salvesta fail. 
22) Vasakul paanil tee uue seadete grupi peal parem klikk, vali New > New Optimized 

Run. 
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23) Nimeta see ümber kui MinLevel. 
24) Sul ei ole vaja muuta midagi paanidel Objective Elements ega ka Pumps to Optimize. 
25) Vali paan Options ning siseta Top Solutions to Keep = 3. 
26) Vali paan Stopping Criteria ning sisesta järgmised väärtused: 

 
• Maximum Trials = 100 000 
• Maximum Non Improvement Generations = 200 

 
27) Teised paanid jäävad nii nagu on. 
28) Salvesta fail ning kliki nupul Compute (dialoogis Darwin Scheduler). 

 
Märkus: Pane tähele, et nüüd võtab konfliktivaba (Violation = 0) lahenduse leidmine märksa 
rohkem aega. 
 

 
 

29) Peale arvutuse lõppu, kliki Close. 
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Lahendi läbivaatus 
 

1) Vali vasakult paanilt Solutions ning vaata 3 esimest lahendit. 
 

 
 

2) Vali lahend Solution 1 ning kliki Export to Solution. Sellega eksporditakse tulemused 
stsenaariumisse. 

 

 
 

3) Veendu, et Export to Scenario? oleks valitud ning jätka vaikimis nimetustega. 
4) Kliki OK, et saata info stsenaariumisse. 

 

 
 

5) Peale stsenaariumisse eksporti kuvatakse sulle järgmine teade. 
6) Kliki OK, et sulgeda Darwin Scheduler. 
7) Vali menüüst Analysis > Scenarios ning kontrolli, et uus stsenaarium on loodud. 
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8) Vali uueks aktiivseks stsenaariumiks MinLevel -1. 
9) Käivita stsenaarium nupust Compute (nt riba pealt: Analysis > Compute). 
10) Vaata tulemusi, mis esitatakse Calculation Summary dialoogis. 
11) Sulge dialoog Calculation Summary (peale tulemuste vaatamist). 
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Maksumusanalüüsi läbiviimine stsenaariumile MinLevel -1 
 

1) Ava dialoog Scenario Energy Cost (Analysis > Energy Cost > Scenario Energy Cost). 
2) Vali stsenaarium MinLevel -1 ning kliki Compute nupul. 

 

 
 

3) Lisa tulemused materjali lõpus olevasse tabelisse. 
4) Kliki Close, et sulgeda dialoog Scenario Energy Cost. 

 
Mahuti veetasapinna graafiku loomine erinevatele stsenaariumitele 
 

1) Joonise alas vali T-1. 
2) Hoia all CTRL klahvi ning vali ka T-2 ning T-3. 
3) Parem klikk ning vali Graph. 
4) Dialoogis Graph Series Options vali All Pumps -1  ning MinLevel -1 stsenaariumid. 
5) Tühista valik Hydraulic Grade ning vali Level (Calculated). 
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Maksumusanalüüsi läbiviimine stsenaariumile MinLevel -1 
 

1) Ava dialoog Energy Costs (Analysis > Energy Costs). 
2) Vali stsenaarium MinLevel -1 ning kliki Compute nupul. 

 

 
 

3) Lisa tulemused materjali lõpus olevasse tabelisse. 
4) Kliki Close, et sulgeda dialoog Energy Costs. 

 
Mahuti veetasapinna graafiku loomine erinevatele stsenaariumitele 
 

6) Joonise alas vali T-1. 
7) Hoia all CTRL klahvi ning vali ka T-2 ning T-3. 
8) Parem klikk ning vali Graph. 
9) Dialoogis Graph Series Options vali All Pumps -1  ning MinLevel -1 stsenaariumid. 
10) Tühista valik Hydraulic Grade ning vali Level (Calculated). 

 

 
 

6) Kliki OK, et vaadata graafikut. 
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7) Vaata profiile ning animeeri tulemusi. 
8) Salvesta fail ning vasta materjali lõpus olevatele küsimustele. 
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Tulemused 
 
Täida allolevad tabelid ning vasta ka küsimustele. 
 
Stsenaarium Daily Cost, € 
EPS  
All Pumps  
Min Tank Level  

 
 
Näite küsimused 
 

1. Miks oli maksumus kõrgem juhtumil, kus mahuti minimaalne veetasapind oli 
kõrgem? 

 
 
 
 

2. Parimate lahenduste juures on näha samaväärsete pumpade pidevat sisse/välja 
lülimist. Kuidas operaator peaks seda mõistma? 

 
  
 
 

3. Mudeliga 24h (1h samm) arvutus kuuele pumbale annab erinevaid lahendeid kokku 
2^(24x6) = 2.33 x 1043? Kui palju väiksem oleks lahendite arv kui kasutatakse 12 2h 
sammu? 
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Tulemused 
 
Täida allolevad tabelid ning vasta ka küsimustele. 
 
Stsenaarium Daily Cost, € 
EPS 2618 
All Pumps 2383 
Min Tank Level 2385 

 
 
Näite küsimused 
 

1. Miks oli maksumus kõrgem juhtumil, kus mahuti minimaalne veetasapind oli 
kõrgem? 

 
Lahend oli märksa piiratum kui see mida pumbad suudaksid. Lisaks oli vastusurve märksa 
kõrgem, mida pumbad pidid pidevalt üle lööma. 
 
 

2. Parimate lahenduste juures on näha samaväärsete pumpade pidevat sisse/välja 
lülimist. Kuidas operaator peaks seda mõistma? 

 
 Üldjoontes ei suuda Darwin vahet teha paralleelsetel, samaväärsetel pumpadel samas 
 pumplas. Kasutaja ei pea lülitama PMP-1 ning PMP-2 juures näiteks PMP-1 peale 
 samal ajaperioodil (kolme ajasammu) aga võib jätta kas PMP-1 või PMP-2 tööle 
 pidevalt. 
 
 

3. Mudeliga 24h (1h samm) arvutus kuuele pumbale annab erinevaid lahendeid kokku 
2^(24x6) = 2.33 x 1043? Kui palju väiksem oleks lahendite arv kui kasutatakse 12 2h 
sammu? 

 
 2^(24x6) = 4.7 x 1021 
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